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Getting Started 

 

Today we‟ll be talking about Microsoft Excel at an introductory level.  This class does require 

that you have some basic computer skills, and experience with Microsoft Word will help greatly. 

 

What is Excel? 

Microsoft Excel is a specialized piece of software that does spreadsheets.  A spreadsheet 

application allows you to create tables of text, numbers, and formulas.  You can then take these 

tables and perform calculations, do data analysis and reporting, create “what-if” scenarios, and 

other tasks that would be rather tedious to do by hand.  

 

Spreadsheets are made up of columns and rows.  Where a column and a row cross, it‟s called a 

cell, and that‟s where the data is put.  We‟ll look a little closer at this in a moment.  

  

Because Excel organizes information and data, it is very useful both in your home life and for 

office-type tasks.  You can use it to make and organize lists, such as an address book or guest 

list.  Because of its capabilities to do mathematical equations, many use it to do a budget or 

balance a checkbook.  It also makes charts and graphs, so it is nice for doing statistical analysis. 

 

Starting up the program 

You will start Excel just like any other program, using either a shortcut on your desktop, or by 

the start menu. 

The desktop shortcut will look like this:   

 

Otherwise, you can go to the Start menu, choose Programs (or All Programs), then choose 

Microsoft Office, and finally click on Microsoft Excel. 

 

 

The Excel window 

Once you have the program started up, you‟ll notice that it has some parts that will be familiar to 

you, if you use Word.  Other parts are unique to Excel, so let‟s take a moment to look at the 

different parts of the Excel window. 

 

As we talk about each of the parts, label them on the diagram below: 
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File Tab  - The File Tab always appears in the upper left corner of the screen. It contains 

common programs functions like Open, Save, and Print. 

Ribbons – Typical Microsoft Office 2007 Ribbons for accessing functions 

Formula bar – Where formulas are displayed 

Row - horizontal component of a spreadsheet, labeled with numbers.  Excel has up to 16,384. 

Column – vertical component of a spreadsheet, labeled with letters.  Excel holds up to 256. 

Cell - created by a row and column crossing.  These are identified by their row number and 

column letter, which is called their “Cell Reference”.  In the picture above, cell “A1” is 

highlighted.  You can have over 4 million cells in one worksheet, and up to 16 

worksheets in one workbook – that‟s a whole lot of data! 

Worksheet – Individual spreadsheets contained in the same file (aka “Workbook”) 

 

Making a new workbook, saving, getting help, etc 

Because Excel is a Microsoft program, a lot of the basic file functions that you‟re used to will 

work just the same.  Under the File Tab, you‟ll find that you can create a new file, open a 

previously-created file, save the file you‟re working on, do a print preview, etc. 

 

Our example will be a record of pretend household expenditures that we have already created 

named: “Household Expenses.” 

 

Additionally, there is the Help icon.  This will allow you to search for information on how to 

perform a specific task, and receive step-by-step instructions. 
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Moving Around on the Worksheet, Using Worksheets  

 

What’s “the active cell”?  How do I change it? 

The active cell is the cell that is currently being worked in.  In order to type data into a cell, the 

cell must be active.  You can identify the active cell because it will have a darker border around 

it. 

 

Watch as the instructor shows several different active cells.  Can you give the cell 

reference/name?    

 

Using the keyboard to change the active cell 

You can move around the spreadsheet using various keys on the keyboard to change what the 

active cell currently is.   *Of those listed below….Ctrl-Home and Home and most useful. 

 

The arrow keys will move the active cell up, down, left, and right.  The Tab key will move the 

active cell one column to the right.  The Enter key will move the active cell one row down.  

There are some additional special keyboard shortcuts in the table below: 

 

Key Command Effect 

F5 Gives you the “GoTo” command to skip to any cell in the spreadsheet. 

Page Up Moves the active cell one screen up. 

Page Down Moves the active cell one screen down. 

Alt-Page Up Moves the active cell one screen to the left. 

Alt-Page Down Moves the active cell one screen to the right. 

Home Moves the active cell to the first column in the current row. 

Ctrl-Home Moves the active cell to cell A1. 

Ctrl-Page Down Changes to the next worksheet to the right. 

Ctrl-Page Up Changes to one worksheet to the left. 

 

 Take a moment to move around the worksheet using just the keyboard. 

  

Using the mouse to change the active cell 

Place the mouse pointer of the cell you wish to make active.  Click the left mouse button.  

 

You can also click into the “Name Box” in the upper left side of the screen, and type a cell 

location there.  When you hit Enter, you will move to the cell whose name you typed. 

 

Take a moment to move around the worksheet with the mouse.   

 

Are there times you think it might be faster to use one way or the other?   

  

Renaming, adding, deleting, rearranging worksheets 

Excel allows you to have multiple worksheets in one workbook (which is a 

single file with the same name).  This lets you group data that‟s related, but 

still maintain a level of separation between various parts.  In the example 

we‟ll be working through today, we‟ll be making a workbook called 
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“Household Spending”, and have a separate worksheet for each month of the year. 

 

Renaming a worksheet 

To rename an existing worksheet, right-click on the worksheet‟s tab at the bottom of the 

window.  Choose Rename.  

 
The worksheet name will be highlighted; simply type in the new name. 

 

 Let‟s do this: Rename the first worksheet tab: January.  Rename the second worksheet 

tab: February and rename the third worksheet tab as: March. 

 

Adding a worksheet 

There are times when you will want more than the default three worksheets.  Since Excel can 

hold up to 16 in a workbook, you can add more as you need them.  There are 4 methods…here is 

one of them: 

 

One Method: 

 

You can left-click on the unnamed worksheet‟s tab, then…right click and choose: Rename and 

type: April. 

 

Deleting a worksheet 

You can also delete extra worksheets that you no longer need.  There are again two ways to 

delete. 

 

One Method: 

Open the worksheet you want to delete.  (This is VERY 

important, as Excel will automatically delete whichever 

worksheet is open currently!)   

Right-click on the sheet you wish to delete, and choose Delete. 
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Resizing, Adding, Deleting Columns and Rows 

 
In addition to making changes to entire worksheets, you can delete a single column or row.  You 

can also adjust the size of them, to make them larger or smaller to better display your data. 

 

Resizing a column 

 

To resize a column, position your mouse pointer on the right edge of the column header for your 

target column.  Your pointer will change to a vertical bar with two arrows on it.  You can now 

left-click and drag the column to be wider (move right) or narrower (move left). 

 

 Change a couple of columns to be various widths. 

 

Additionally, if your column already had data in it, you could double-click in that same location 

and it would automatically adjust to be as wide as the widest text.   

 

 

Resizing a row 

The technique to resize a row height is almost identical to changing a column width.  Position 

your mouse pointer on the bottom edge of the row header for the row you wish to change.  When 

your pointer changes to the horizontal bar with two arrows, left-click and drag the row to be 

taller (move down) or shorter (move up).  As with changing a column height, the double-click 

technique will work to automatically size the row. 

 

 Change a couple of rows to be various heights. 

Resizing Multiple Columns 
Excel gives you a way to change multiple columns to the 

same width simultaneously.  To do this, you will need to 

first select the columns you wish to resize.  If they are 

side by side, you can click the header of the leftmost 

column, hold down the Shift key, and then click the 

header of the rightmost column.  All of the columns in 

between will now be highlighted.   
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If you wish to resize non-adjacent columns, 

hold down the Ctrl key, and click on each of 

the columns you wish to choose.  They will be 

highlighted as before.  

 

Once you have the columns selected that you 

wish to resize, follow the same technique you 

would to resize any single column – if you 

resize any one of the highlighted columns, they 

will all change to be the same width!   

 

Practice selecting and resizing multiple 

columns, both side-by-side and spaced out. 

 

Resizing multiple rows 

You can use the same technique on resizing 

multiple rows as you do for multiple columns.  

Select the rows you wish to resize (using the 

Shift key for adjacent rows, the Ctrl key for 

non-adjacent rows), then change the size on any 

one of them.  The rest will follow! 

 

 

Deleting a Column 
If you no longer need a particular column, you can delete it to help keep your spreadsheet clean 

looking.  Click the column header of the column you wish to delete to highlight it.  Once 

again…there are 2 ways of deleting a column…here is one method: 

 

One Method: 

Right-click on the column header you wish to remove, and choose Delete from the menu that 

appears.  All of the other columns will shift to the left. 

   

 

Deleting a row 
As with deleting a column, it is easy to delete extra rows you do not need.  Simply select the row 

header of the row you wish to delete to highlight the entire row.  From there, follow the “right-

click” technique.   

 

1. Practice removing a few rows.  Delete some individually and then some multiples. 
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Adding a Column 
You may find sometimes that you need to add a column in between two existing columns.  There 

are, again, two ways to do this.  Here‟s one way, start by highlighting the column to the RIGHT 

of where you want your new column.  (So if you wanted it between existing columns B and C, 

you would click on the header for column C). 

 

 

 

One Method: 

Right-click on the column header for the highlighted column.  Choose Insert.  Excel will 

automatically add a column to the left of your current location. 
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Adding a Row 
To add a row, you will follow the same process as adding a column.  Simply choose the row 

BELOW the location of the new row and “right click” and select: Insert.   

 

 Practice by adding a few rows at various places in the worksheet. 

 

Entering and Editing Data 

Now we get into the good stuff – getting your information into Excel so you can make it work 

for you! 

 

Typing Data in a Worksheet, Types of Data 

As you might expect, this is simply a matter of typing the data you have into the appropriate 

place in the worksheet.  Which ever cell is the active cell will be the recipient of what you‟re 

keying in.  From our discussion on moving around the worksheet, you will know that you can 

move the active cell by using either the keyboard or the mouse, or some combination thereof. 

 

It helps to think of three types of data that you may put into Excel.  These are: labels, constants, 

and formulas. 

 

Data Type Description Examples 

Labels Anything that is just text, 

meant to help a person 

understand the spreadsheet 

Check Number 

Recipient 

Address Line 1 

Constant Any numbers that are not 

automatically calculated 

$5.75 

1,047 

22 

Formulas Equations/calculations.  Could 

be numbers, cell references, 

functions, or a combination.  

Always starts with an = 

=5+3 

= C2 * D12 

= SUM(B23:B25) 

 

Autofill 

Excel has a tool called “AutoFill” that allows you to fill in large 

groups of numbers or dates without having to type each of them in.  

The tool will detect patterns and continue them for you. 
 

To make use of the tool, we will use the monthly budget 

spreadsheet file that is already created.  Select the last two Check 

Number cells that contain the data as it appears to your right.   
 

The most important part of the picture above is the small black 

square in the bottom right corner of the selected area.  To fill in 

additional cells, you simply click-and-drag that box down as many 

rows as you wish to autofill.  (Autofill will also work across 

columns, if you enter your original data that way). 
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Let’s do this! 

In this same worksheet, practice doing the following: 

1. Filling in a series of sequential numbers (1012, 1013, 1014 & 1015). 

2. Filling in a series of dates (8/12/2007, 8/13/2007, 8/14/2007 & 8/15/2007) 

3. Filling in a series Category patterns (Utilities, Entertainment & Car). 

 

Editing a cell by keyboard and mouse 

To enter data, use either the keyboard or mouse to the cell where you wish to enter data.  If you 

find that you need to change a cell where you have already entered information, simply make 

that cell active again (using either the keyboard or the mouse), and enter your changes. 

 

Re-create the spreadsheet shown below.  Use the techniques above to adjust your column widths 

to be wide enough for what they contain.  Use the autofill technique to fill in the “check number” 

column, “date” column and “Category” column.  

 

 

Search and replace data 

It is straightforward to find a particular piece of data in a spreadsheet, which can save you a lot 

of time if it is very large, and you are simply looking for a particular entry. 

 

 

To use the search function, first make the A1 cell into the 

active cell for your worksheet.  Then go to the Find & 

Search function and choose Find.   
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In the box that appears, type the word, phrase, or number you wish to search for and click the 

“Find Next” button.  That will move the active cell to the next instance of your search criteria. 

 
 

If you wish to know everywhere that your term appears on the worksheet, click the Find All 

button.  A new section will get added to the “Find and Replace” window, listing each Cell 

location where your search term appears.  You can click on each listing to go to that particular 

place in the spreadsheet. 

 
 

Now that you‟ve seen this done, work on your own spreadsheet and do a “Find Next” and a 

“Find All” for „Giant Eagle‟. 

 

Additionally, you may have noticed the “Replace” tab in the “Find and Replace” window.  This 

will allow you to not only find a particular term, but gives you the option of replacing it with a 

different one.  In our example, let‟s pretend we no longer want to use the category “Groceries”, 

because we‟ve chosen to include dining out in that budget category.  So we‟re going to find each 

instance of “Groceries” and replace it with the more-generic “Food”. 
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You simply type the term you‟re looking for in the “Find what” box, and the new term into the 

“Replace with” box.  You can then choose to just replace the first instance of it (using the 

Replace button) or all instances of it (Replace all). 

 

 
 

 Click the: “Replace all” on your worksheet, to change “Groceries” to “Food”. 

 

Making your work look good (Formatting data and the sheet) 

So now that you‟ve gotten the basics of entering information, let‟s take a look at what we can do 

to make the important things really stand out. 

 

Formatting Text 

All of the usual techniques you already know from Microsoft Word will still work in Excel to 

format text.  

 

Using the Font Functional Area on the Home Ribbon, you can make items bold, italicized, 

underlined, or any combination.   You can also change to a different font (Arial, Times New 

Roman), or a different font size (10 for smaller font, 14 for bigger, etc). 

 

 
 

 

You can also change the cell contents to be left-justified, right-justified, or centered in their 

particular column. 

 

You could also change the background color of the cells with the paint can, or the color of the 

font.  If you‟re familiar with tables in Word, you‟ll also recognize the icon to draw borders 

around areas of the spreadsheet. 
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Formatting changes only apply to the active cell(s).  This makes the formatting very powerful, 

because you can make different sections of your spreadsheet have different formats for emphasis.  

This also means that you can make use of your skills to select multiple cells, an entire row or 

column, or a group of rows/columns, and apply the formatting to them all at once. 

 

**In your practice spreadsheet, make these formatting changes (as shown below): 

1. row of column headings underlined and in bold 

2. left-justify the “Check Number” column 

3. make the contents of the “Category” column italicized 

4. (optional) – choose a different font or font size for the whole sheet 

 

 

Freezing Headings 

Because tables full of numbers can be less-than-friendly to look at, when they get beyond one 

screen tall/wide, Excel allows you to “freeze” columns or rows so that they will never move off 

the screen.  This allows you to create rows/headers that can function as labeled headers. 

 

To see why this could be useful, start scrolling right in your workbook; notice how the labels 

disappear? 

 

In order to use this function, first decide which rows and/or columns you wish to have showing 

at all times.  The freeze will take effect in the row ABOVE the active cell, and the column to the 

LEFT of the active cell.  This means that if you do not want to freeze a row, but merely a 

column, make sure you are in Row 1.  Since there are no rows above it, the freeze will not affect 

any rows.  If you want to only freeze a row, make sure you are in Column A. 
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Once you have made the appropriate cell active, choose the View ribbon, then Freeze Panes -> 

Freeze Panes.   

 

 

 

 Decide somewhere on your sheet that you want to freeze, and do so. 

 

To unfreeze your sheet, go again to the View ribbon.  You‟ll see that the option has now changed 

to Freeze Panes -> Unfreeze Panes.  Click that to undo the freezing process.  You can turn this 

on and off as many times as you wish in a spreadsheet; this can be useful if you have a huge 

sheet and you‟re doing a number of different processes on it. 

 

 Unfreeze your worksheet.  Then, freeze only Row 1 since that contains our headers.   

 

Centering titles 

You can also make headers or individual cells that span more than one column, using a function 

called “Merge and Center”.  This can be useful to add a second level of information, or grouping 

multiple cells.  It will combine multiple columns into a single one, and make that cell span all of 

the columns.  (Note that this also works on rows)   

 

To use this, first select the cells you wish to merge.  Then click the “Merge and Center” icon in 

the Home Ribbon.  

 

 

 

If there is data already in the cells, it will be combined into one.  You can also make the new 

“super cell” active and edit/add data to it. 
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For practice, Click on: cell A24 and type: This class is really fun!   Notice how these phrase 

encroaches into the next row.  You could just expand the row, but…sometimes you may want to 

just expand that information into the cell next to it. 

Now…Click on that cell and also on B24.  This will select both cells.  Now click the “Merge and 

Center” icon. 

 

Formatting Numbers 

Excel has extensive options available to format all types of numbers, from different types of 

monetary notation to dates.  You can, again, apply formats to one particular cell or a group of 

cells. 

 

First, select the cell(s) you wish to apply the formatting to.  Then in the Home ribbon, change 

drop-down box under the Number function area and choose the 

proper format.   

 

 

Or you can Click the “More Options” icon (the downward facing    

                                                  arrow at the bottom of the box to  

                                                 display the Format Cells dialog box.  

 

 

In the window that comes up, make sure to select the Number tab.  You can then choose the 

“Category” of number in the left column, and the right side will allow you to set very specific 

options based on the category.  There is also a field that will show you a sample of the format. 

 

When you‟re satisfied with the options, click OK to apply them to your active cells. 

 

 

**I prefer to just Right Click on that cell 

or highlighted tab and select Format.  This 

gives me a Format Dialog Box with more 

options…or for more options, you can 

click the number dialog box launcher icon. 

 

The categories you will probably use most 

are “Currency” (if you‟re dealing with 

money), Date, and Text (for labels). 
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Let’s do this: 

Change the contents of your “date” column to be in format of August 3, 2007. 

Change the contents of the “Budgeted Amount” to have no decimal places ($65 instead of 

$65.00).  Make sure the contents of the “Check Number” column are numbers with no decimal 

places. 

Page Margins, Headers and Footers 

You can also control how your file will look when printed.  There are quite a few options for the 

print layout, but we will just cover a few basics. 

 

The page margins refer to how much white space remains above, below, and to either side of 

your information when it is printed onto paper.  Excel uses smaller default margins that other 

programs such as Word: 1” top and bottom, .75” left and right.  You can modify these to give 

yourself more room for handwritten notes (make the margins larger), or to fit more printed 

material on the page (make the margins smaller). 

 

To change the margins, go to the Page Layout ribbon and choose 

Margins.   

 

 

 

 

 

Click on the Custom Margins option, and make any adjustments 

necessary. 

 
**To print gridlines…you Click on the Sheet tab and select the Gridlines box. 
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The header of a document is information that prints above the normal spreadsheet, such as a title 

for the whole item.  The footer, similarly, prints below the normal part of the page, and often 

contains information like the page number or a printed date. 

 

In Excel, these are available by clicking Page Layout ribbon, then the Page Setup More 

Options arrow. Choose the Header/Footer tab.  You can make use of pre-defined 

headers/footers by choosing from the drop down lists.  

 

Alternatively, you can create you own unique header or footer, by clicking the “Custom Header” or 

“Custom Footer” button.  Clicking that will give you the screen shown below; simply enter the 

information in the appropriate area and click OK.  You can control the size of the font and where it 

falls (left, center, right), as well as inserting some special features (automatic page number, date 

stamping, etc).     
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 Add the standard header that prints the filename at the top of the page (Household 

expenses.xls) 

 

 Create a custom footer that contains today‟s date in the left section, your name in the 

center section, and the page number in the right section. 

 

One other change that you may find helpful for a spreadsheet with more columns that rows 

(meaning it‟s wider than it is tall) is the ability to have the paper print out “landscape”.  This is 

also under Page Setup->Orientation.  Simply choose “Landscape” to change the paper 

orientation. 

 

You can use the print preview feature to see what your header/footer will look like on the printed 

page.  (File > Print).   The preview will be revealed to the right, if you want to get out of this 

screen, just click on the Home tab. 

 

Basic calculations 

The real power of Excel comes by way of formulas and functions.  These allow you to do 

calculations, manipulations, and analysis of all those numbers you typed in.  This is covered in 

greater depth in our “Intermediate Excel” class, but we‟ll cover a few basic ones to get you 

started. 

 

What are formulas and functions? 

In Excel, a formula is an equation to perform some sort of calculation in your worksheet.  It 

could contain any combination of numbers, cell references, mathematical operators, and 

functions.  They always start with an equals sign (= ) so that Excel knows to “do” the contents of 

the cell, rather than displaying them. 
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Sample formulas would include: 

=7-5+9   (Subtracts 5 from 7, then adds 9 to the result.  The cell would display 11) 

=A2+B9 (Adds whatever number is in cell A2 to the number in cell B9 and displays the result) 

 

A function is a prewritten formula that you can include in your sheet, simply putting in the 

appropriate values.  You‟ll find that a lot of the calculations you‟ll want to do already have 

functions written that you make use of, and they are very helpful if making a lengthy calculation 

clearer.  They generally take the form of the function name, followed by the values/references in 

parentheses.     

 

Sample functions include: 

=SUM(C7:C22) (Adds together all the values in every cell from C7 through C22 and displays it) 

=AVERAGE(2,3,4,5,6)  (Finds the average of 2, 3, 4, 5, 6 and displays it) 

 

Doing simple calculations 

In their simplest form, you can use formulas and functions to do the same types of calculations 

that you might perform by hand or with a calculator.  The advantage to doing them in Excel is 

that they‟ll be done quicker, you can save them to perform over and over on demand, and you 

they change automatically as you put in new numbers.  We‟ll look first at basic math functions. 

 

Basic math functions (add, subtract, multiply, divide) 

You can make use of the basic math “operands” to do addition, subtraction, multiplication, and 

division on the data in your spreadsheet.  These don‟t require much special; just use the 

appropriate key on the keyboard: 

Symbol Function 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

 

The actual cell where you put the formula will show the result of the calculation.  The formula 

bar at the top will show the formula itself.  If you wish to change a formula that you have already 

entered, click the formula bar and make your changes there. 

 

On your spreadsheet, pick an open area and enter a few basic math calculations like those shown 

below.  Remember to put the equals sign at the beginning. 

 

=4+8+12  (will display 24) 

=28/4.5  (will display 6.2222) 

=999 * 5 / 12  (will display 416.25) 

 

In addition to using plain numbers, remember that you can use cell references.  That will allow 

you to perform calculations on data you have already entered and have the formula update as you 

change the data. 
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 First, confirm that your value in E3 is $144.  Then, click in the blank cell (E20) enter the 

following formula: =E4*2   

 

What does it display? 

 

 Next, change the value of E4 to be $188.  Now what does your formula return? 

 

 

Sum, averaging, min, max 

The next level of formulas use is to take advantage of the built-in functions.  The ones we will 

talk about today are SUM (adds up all the numbers), AVERAGE (finds the average of the 

numbers), MIN (finds the smallest number), and MAX (finds the largest number). 

 

There are two ways to enter a function.  The first is to type it in by hand like a formula. 

 

Like the basic formulas, these will always start with an Equals sign.  You then put the name of 

the function, followed by an opening parenthesis.  Enter the numbers you want to perform the 

calculation on separated by commas, and then put the closing parenthesis. 

 

As you start to type, you will get a little yellow prompt box, reminding you of the proper format. 

 

 
 

The second option is to make use of the Function Wizard.  This is particularly useful if you can‟t 

remember the exact name of a function, or the proper format for putting information in.  To start 

the wizard, click the Formulas ribbon and choose Insert Function. 

 

 

A new window will come up, prompting you to choose the type of function you want to use.  

The ones you use most often will show up automatically.  Otherwise, you can choose the 

category of functions (“All” will show you everything that is available) to get a more complete 

listing.  Highlight the function you wish to use and click OK. 
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Excel will then give you a window where you can type the numbers, range of numbers, cells, etc, 

to perform the calculation on.  It will also show you the formula result as you enter each new 

piece of data.  (The precise layout of this screen may vary for different functions).  When you‟ve 

entered all your data, click OK to return to the spreadsheet. 
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Practice a few functions, using both the method of hand entry and the wizard. Which one do you 

prefer?  Some sample functions to try: 

 

Find the average of 2, 3, 4, 5, 6.  (Function: AVERAGE) 

Find the largest number in the values: 37, 99, 256  (Function name: MAX) 

Find the smallest number in the values: 37, 99, 256 (Function name: MIN) 

 

Just like basic formulas, you can also use cell references instead of having to type in numbers, 

and the function will update as the values in the cells change. 

 

When you use cell references, there is one other neat feature to save you some time.  If you are 

applying a formula or function to a range of adjacent cells, you don‟t have to type each cell 

reference individually. You can instead enter the first and last cell references, separated by a 

colon.  So, if you wanted to apply the function to everything in cells A2 through A12, you would 

write it as A2:A12, instead of A2, A3, A4, A5, A6, A7, A8, A9, A10, A11, A12.  

 

In cell A25, enter the formula to automatically add up everything in column A, rows 3 through 

17.  (Function: SUM) 

 

Excel is also smart enough to copy formulas from one cell to another and update the cell 

references to reflect the new location.   

 

Click into A25 and copy the formula there (Home-Copy, or Ctrl+C on the keyboard).  Now 

paste that formula into E25 (Home-Paste or Ctrl+V on the keyboard).  Look at the formula bar 

while in cell E25 – the cell references have all changed appropriately! 

 

Now we‟re going to show you why using cell references is so wonderfully powerful, and put 

together several different things we‟ve learned. 

 

First, delete all the practice formulas and functions you have added to your spreadsheet.  Then, in 

cell E25, write the function to automatically add up everything from E4 through E24.  Copy that 

function over to F25.   This will give you totals of all your “household expenses” in their actual 

cost (column E), and their budgeted amount (column F).   

 

Now, in cell G25, write the function to show the difference between what you expected to spend 

and actually spent.  (Hint: use subtraction)  Use cell references to write the function. 

 

Enter two new expenses in rows 19 and 20.  Use the autofill to complete the next check numbers 

and dates. Use any category for the expenses you‟d like, and make up the payee, amounts, and 

budgeted amounts (make the actual and budgeted amounts different, though).     

 

Watch what happens to the totals in E25 and F25, and the difference in G25.  
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In Conclusion 
 

At this point, you should be able to make use of Microsoft Excel to create and move around in a 

spreadsheet, make it look how you would like on screen and in print, make changes to the data 

you‟ve entered, and automate simple calculations.  **There are many spreadsheet templates that 

you can access from the Office Button…and by selecting:  New to reveal a variety of excel 

templates that you can download from Microsoft‟s website! 

 

Other things to practice on your own! 
 

Styles (Formerly AutoFormat) 

There are also a number of pre-defined styles in Excel that you can apply.  While you can use 

them on a small section of a spreadsheet, they are designed for large sections or the whole sheet 

(as you‟ll see shortly).  These may contain background colors, text changes, etc. 

 

To use a Style, first select the area you wish to format.  Under the Home ribbon, choose Format 

as Table 

 
 

A window will appear, showing you the various types of pre-defined formats you could use.  

 

 

 

 

 

 

Choose the format you wish to use. 

 

For practice, select your entire spreadsheet, and apply 

a sample Style.  Notice that it wipes out the formatting 

you‟ve done by hand.  If you like the Style better, 

leave it in place.  Otherwise, undo it by using the 

“Undo” command at the top of the page. 

 

 

 

 

 



Page 24 of 24 

 

Borders and Shading 
Excel allows you to emphasize the grid-like nature of a spreadsheet by adding borders to 

individual cells or groups of cells.  These borders can be plain or fancy, with a number of 

different options. 

 

As always, begin by selecting the cells to which you want to apply the formatting.   

 

For very basic borders, choose the downward arrow on the Borders icon in the Home Ribbon, 

and click on the style of formatting you wish to apply. 

 

 
 

You can see additional border options, including alternate line styles and colors, by going to the 

Home ribbon, choosing the Borders Drop-Down box, and then going to the More Borders 

option. 

 

 

 

Add some borders to your 

spreadsheet that help make 

it clearer to you.  If you 

don‟t like a border that you 

add, remember you can 

always make use of the 

“Undo” function. 

 


